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Share — copy and redistribute the material in any medium or format for any purpose, even commercially. Adapt — remix, transform, and build upon the material for any purpose, even commercially. The licensor cannot revoke these freedoms as long as you follow the license terms. Attribution — You must give appropriate credit , provide a link to the
license, and indicate if changes were made . You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use. ShareAlike — If you remix, transform, or build upon the material, you must distribute your contributions under the same license as the original. No additional restrictions — You may not apply
legal terms or technological measures that legally restrict others from doing anything the license permits. You do not have to comply with the license for elements of the material in the public domain or where your use is permitted by an applicable exception or limitation . No warranties are given. The license may not give you all of the permissions
necessary for your intended use. For example, other rights such as publicity, privacy, or moral rights may limit how you use the material. Unlock the full potential of your computer with our 500+ PC shortcut keys list, designed to streamline your workflow and save you time. Whether you're working in Microsoft Office, browsing the web, or using
operating systems like Windows, macOS, or Linux, keyboard shortcuts allow you to navigate and perform tasks more efficiently. From Microsoft Word, Excel, and PowerPoint to web browsers like Chrome, Firefox, and Edge, every platform has its own set of shortcuts that can save you valuable time.Note: Whether you're on Windows, Mac, or a Linux
system, mastering computer shortcut keys will streamline your workflow, save you time, and help you navigate digital tools effortlessly.You'll discover time-saving shortcuts for applications like Google Docs, Tally, Visual Studio Code, and Android Studio, as well as browser-specific shortcuts for Chrome, Safari, Opera, and even Tor. Plus, we've
included solutions for common shortcut-related issues and tips for customizing your keyboard settings, ensuring you get the most out of your computing experience.Complete List of Computer Shortcut KeysWhat Are Keyboard Shortcuts?Keyboard shortcuts are a combination of keys that perform a specific action or command without having to use
your mouse. These shortcuts allow you to execute tasks quickly and efficiently. For example, pressing Ctrl + C copies selected text, while Ctrl + V pastes it. With Mac, the shortcuts may vary slightly (using Command instead of Ctrl), but the principle remains the same.Microsoft Office & Productivity Software ShortcutsWeb Browser
ShortcutsOperating System & Terminal ShortcutsMost Used Advanced ShortcutsMost Common Keyboard Shortcuts for All PlatformsWindows Keyboard Shortcuts: Boost Your EfficiencyWindows shortcut keys are indispensable for anyone using Windows 7, 8, 10, or 11. These shortcuts can help you perform tasks like opening the task manager,
capturing screenshots, or navigating between virtual desktops.Ctrl + C - CopyCtrl + V - PasteCtrl + X - CutAlt + Tab - Switch between open applicationsWindows + D - Show desktopWindows + L - Lock your PCCtrl + Shift + Esc - Open Task ManagerWindows + Print Screen - Take a full screenshotMac Keyboard Shortcuts: Navigate Your macOS
SystemFor Mac users, mastering shortcuts will help you access menus, navigate between apps, and use advanced features without fumbling with the mouse. Here’s a breakdown of MacOS keyboard shortcuts:Command + C - CopyCommand + V - PasteCommand + X - CutCommand + Z - UndoCommand + Space - Open Spotlight searchCommand +
Shift + 4 - Take a screenshot (select area)Command + Option + Esc - Force quit appsLinux Keyboard Shortcuts: Efficient Command-Line NavigationLinux users often rely on terminal-based commands. Mastering Linux keyboard shortcuts will help you quickly navigate the system, execute commands, and perform various tasks directly in the
command-line interface.Ctrl + C - Cancel the current commandCtrl + L - Clear the terminal screenCtrl + A - Move to the beginning of the lineCtrl + E - Move to the end of the lineAlt + Tab - Switch between applicationsBrowser-Specific Shortcuts: Save Time OnlineNavigating through web browsers quickly and efficiently is essential in today’s
internet-centric world. Below are some browser shortcut keys for popular browsers:Google Chrome ShortcutsCtrl + T - Open new tabCtrl + W - Close current tabCtrl + Shift + T - Reopen last closed tabCtrl + Tab - Switch to next tabCtrl + Shift + N - Open an incognito windowMicrosoft Edge ShortcutsCtrl + Shift + P - Open InPrivate browsingCtrl
+ F - Find text on pageCtrl + R - Reload pageCtrl + L - Focus the address barSafari ShortcutsCommand + T - Open a new tabCommand + W - Close current tabCommand + Shift + T - Reopen the last closed tabCommand + Option + F - Open the search barOpera ShortcutsCtrl + Shift + T - Reopen last closed tabCtrl + W - Close tabCtrl + Shift + N
- Open a new private tabCtrl + F - Open find in pageAdvanced Shortcuts: Take Your Efficiency to the Next LevelFunction Key ShortcutsFunction keys (F1-F12) offer a variety of commands to enhance your workflow. Here are some popular function key shortcuts:F1 - Open HelpF2 - Rename a file or folderF5 - Refresh the page or documentF11 -
Toggle full-screen modeClipboard ShortcutsWhen it comes to text editing, clipboard shortcuts are essential for faster content manipulation:Ctrl + C - Copy textCtrl + X - Cut textCtrl + V - Paste textCtrl + Z - UndoCtrl + Y - RedoWindows Snipping Tool and Screenshot ShortcutsTaking screenshots is quick and easy with Windows screenshot
shortcuts. Use these key combinations to capture and annotate your screen:Windows + Shift + S - Open Snipping Tool (select part of the screen)PrtScn - Capture the full screenAlt + PrtScn - Capture the active windowHow to Customize Your Keyboard ShortcutsWindows, Mac, and Linux all allow you to customize your keyboard shortcuts. This
feature is useful if you need shortcuts tailored to your workflow. On Windows, you can assign hotkeys to specific programs through the properties window, while MacOS allows shortcut modification through the System Preferences.Troubleshooting: What to Do When Shortcuts Don't WorkKeyboard shortcuts can sometimes stop working due to
software issues or configuration problems. Here are some common troubleshooting tips:Check Keyboard Settings: Ensure that the keyboard shortcuts are not disabled in your system preferences or browser settings.Update Drivers: Outdated keyboard drivers can cause shortcuts to malfunction. Update your drivers through the Device Manager
(Windows) or System Preferences (Mac).Restart Your Device: Sometimes a simple restart can fix glitches with shortcuts not functioning properly.Use an External Keyboard: If you're using a laptop keyboard and shortcuts aren’t working, try plugging in an external keyboard to see if the issue is hardware-related.ConclusionMastering keyboard
shortcuts is a game-changer for anyone who works with computers. Whether you're navigating through Microsoft Word, Excel, or browsing the internet, using shortcuts can significantly speed up your workflow. As you become familiar with these shortcuts, you’ll notice a drastic improvement in your efficiency, allowing you to focus more on your tasks
and less on navigating through menus.By regularly practicing and integrating these shortcuts into your daily routine, you’ll save valuable time and improve your productivity. Now, go ahead and start using the shortcuts that best fit your needs! Unlock the full potential of your computer with our 500+ PC shortcut keys list, designed to streamline your
workflow and save you time. Whether you're working in Microsoft Office, browsing the web, or using operating systems like Windows, macOS, or Linux, keyboard shortcuts allow you to navigate and perform tasks more efficiently. From Microsoft Word, Excel, and PowerPoint to web browsers like Chrome, Firefox, and Edge, every platform has its own
set of shortcuts that can save you valuable time.Note: Whether you're on Windows, Mac, or a Linux system, mastering computer shortcut keys will streamline your workflow, save you time, and help you navigate digital tools effortlessly.You'll discover time-saving shortcuts for applications like Google Docs, Tally, Visual Studio Code, and Android
Studio, as well as browser-specific shortcuts for Chrome, Safari, Opera, and even Tor. Plus, we've included solutions for common shortcut-related issues and tips for customizing your keyboard settings, ensuring you get the most out of your computing experience.Complete List of Computer Shortcut KeysWhat Are Keyboard Shortcuts?Keyboard
shortcuts are a combination of keys that perform a specific action or command without having to use your mouse. These shortcuts allow you to execute tasks quickly and efficiently. For example, pressing Ctrl + C copies selected text, while Ctrl + V pastes it. With Mac, the shortcuts may vary slightly (using Command instead of Ctrl), but the principle
remains the same.Microsoft Office & Productivity Software ShortcutsWeb Browser ShortcutsOperating System & Terminal ShortcutsMost Used Advanced ShortcutsMost Common Keyboard Shortcuts for All PlatformsWindows Keyboard Shortcuts: Boost Your EfficiencyWindows shortcut keys are indispensable for anyone using Windows 7, 8, 10, or 11.
These shortcuts can help you perform tasks like opening the task manager, capturing screenshots, or navigating between virtual desktops.Ctrl + C - CopyCtrl + V - PasteCtrl + X - CutAlt + Tab - Switch between open applicationsWindows + D - Show desktopWindows + L - Lock your PCCtrl + Shift + Esc - Open Task ManagerWindows + Print
Screen - Take a full screenshotMac Keyboard Shortcuts: Navigate Your macOS SystemFor Mac users, mastering shortcuts will help you access menus, navigate between apps, and use advanced features without fumbling with the mouse. Here’s a breakdown of MacOS keyboard shortcuts:Command + C - CopyCommand + V - PasteCommand + X -
CutCommand + Z - UndoCommand + Space - Open Spotlight searchCommand + Shift + 4 - Take a screenshot (select area)Command + Option + Esc - Force quit appsLinux Keyboard Shortcuts: Efficient Command-Line NavigationLinux users often rely on terminal-based commands. Mastering Linux keyboard shortcuts will help you quickly navigate
the system, execute commands, and perform various tasks directly in the command-line interface.Ctrl + C - Cancel the current commandCtrl + L - Clear the terminal screenCtrl + A - Move to the beginning of the lineCtrl + E - Move to the end of the lineAlt + Tab - Switch between applicationsBrowser-Specific Shortcuts: Save Time OnlineNavigating
through web browsers quickly and efficiently is essential in today’s internet-centric world. Below are some browser shortcut keys for popular browsers:Google Chrome ShortcutsCtrl + T - Open new tabCtrl + W - Close current tabCtrl + Shift + T - Reopen last closed tabCtrl + Tab - Switch to next tabCtrl + Shift + N - Open an incognito
windowMicrosoft Edge ShortcutsCtrl + Shift + P - Open InPrivate browsingCtrl + F - Find text on pageCtrl + R - Reload pageCtrl + L - Focus the address barSafari ShortcutsCommand + T - Open a new tabCommand + W - Close current tabCommand + Shift + T - Reopen the last closed tabCommand + Option + F - Open the search barOpera
ShortcutsCtrl + Shift + T - Reopen last closed tabCtrl + W - Close tabCtrl + Shift + N - Open a new private tabCtrl + F - Open find in pageAdvanced Shortcuts: Take Your Efficiency to the Next LevelFunction Key ShortcutsFunction keys (F1-F12) offer a variety of commands to enhance your workflow. Here are some popular function key shortcuts:F1
- Open HelpF2 - Rename a file or folderF5 - Refresh the page or documentF11 - Toggle full-screen modeClipboard ShortcutsWhen it comes to text editing, clipboard shortcuts are essential for faster content manipulation:Ctrl + C - Copy textCtrl + X - Cut textCtrl + V - Paste textCtrl + Z - UndoCtrl + Y - RedoWindows Snipping Tool and Screenshot
ShortcutsTaking screenshots is quick and easy with Windows screenshot shortcuts. Use these key combinations to capture and annotate your screen:Windows + Shift + S - Open Snipping Tool (select part of the screen)PrtScn - Capture the full screenAlt + PrtScn - Capture the active windowHow to Customize Your Keyboard ShortcutsWindows, Mac,
and Linux all allow you to customize your keyboard shortcuts. This feature is useful if you need shortcuts tailored to your workflow. On Windows, you can assign hotkeys to specific programs through the properties window, while MacOS allows shortcut modification through the System Preferences.Troubleshooting: What to Do When Shortcuts Don't
WorkKeyboard shortcuts can sometimes stop working due to software issues or configuration problems. Here are some common troubleshooting tips:Check Keyboard Settings: Ensure that the keyboard shortcuts are not disabled in your system preferences or browser settings.Update Drivers: Outdated keyboard drivers can cause shortcuts to
malfunction. Update your drivers through the Device Manager (Windows) or System Preferences (Mac).Restart Your Device: Sometimes a simple restart can fix glitches with shortcuts not functioning properly.Use an External Keyboard: If you're using a laptop keyboard and shortcuts aren’t working, try plugging in an external keyboard to see if the
issue is hardware-related.ConclusionMastering keyboard shortcuts is a game-changer for anyone who works with computers. Whether you’re navigating through Microsoft Word, Excel, or browsing the internet, using shortcuts can significantly speed up your workflow. As you become familiar with these shortcuts, you’ll notice a drastic improvement in
your efficiency, allowing you to focus more on your tasks and less on navigating through menus.By regularly practicing and integrating these shortcuts into your daily routine, you’ll save valuable time and improve your productivity. Now, go ahead and start using the shortcuts that best fit your needs! Share — copy and redistribute the material in any
medium or format for any purpose, even commercially. Adapt — remix, transform, and build upon the material for any purpose, even commercially. The licensor cannot revoke these freedoms as long as you follow the license terms. Attribution — You must give appropriate credit , provide a link to the license, and indicate if changes were made . You
may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use. ShareAlike — If you remix, transform, or build upon the material, you must distribute your contributions under the same license as the original. No additional restrictions — You may not apply legal terms or technological measures that legally
restrict others from doing anything the license permits. You do not have to comply with the license for elements of the material in the public domain or where your use is permitted by an applicable exception or limitation . No warranties are given. The license may not give you all of the permissions necessary for your intended use. For example, other
rights such as publicity, privacy, or moral rights may limit how you use the material. This is a dynamic list and may never be able to satisfy particular standards for completeness. You can help by adding missing items with reliable sources.For keyboard shortcuts in Wikipedia, see Wikipedia:Keyboard shortcuts. In computing, a keyboard shortcut is a
sequence or combination of keystrokes on a computer keyboard which invokes commands in software. Most keyboard shortcuts require the user to press a single key or a sequence of keys one after the other. Other keyboard shortcuts require pressing and holding several keys simultaneously (indicated in the tables below by the + sign). Keyboard
shortcuts may depend on the keyboard layout. Main article: Keyboard shortcut Keyboard shortcuts are a common aspect of most modern operating systems and associated software applications. Their use is pervasive enough that some users consider them an important element of their routine interactions with a computer. Whether used as a matter
of personal preference or for adaptive technology, the pervasiveness of common conventions means that a meaningful comparison of keyboard shortcuts can be made across various widely used operating systems. Many shortcuts (such as Ctrl+Z, Alt+E, etc.) are just common conventions and are not handled by the operating system. Whether such
commands are implemented (or not) depends on how an actual application program (such as an editor) is written and the frameworks used. Not all applications/frameworks follow (all of) these conventions, so if it doesn't work, it isn't compatible. Some of the combinations are not true for localized versions of operating systems. For example, in a non-
English version of Windows, the Edit menu is not always bound to the E shortcut. Some software (such as KDE) allow their shortcuts to be changed, and the below list contains the defaults. Action Windows macOS[notes 1] Linux Emacs Vim ChromeOS File menu Alt+F, or F10 then F Ctrl+F2, then F[notes 2] Alt+F Meta+", then f Alt+f (gvim) or
Ctrl+e (vim + NERDTree) Ctrl+0O Edit menu Alt+E Ctrl+F2, then E[notes 2] Alt+E Meta+ ", then e Alt+e (gvim) View menu Alt+V Ctrl+F2, then V[notes 2] Alt+V Undo the last operation Ctrl+Z, or Alt+«< Backspace 8 Cmd+Z Ctrl+Z Ctrl+x, then u or Ctrl+/ or Ctrl+_ or Undo u Ctrl+Z Redo the last operation Ctrl+Y, or Alt+Shift+Backspace 1
Shift+3 Cmd+Z Ctrl+ 1 Shift+Z, or Ctrl+Y Same as undo, when undo is exhausted, it redoes. Move the cursor after one or more undos, and further undos will be redos. Since version 28, also Ctrl+? or Ctrl+Alt+ . Ctrl+r Ctrl+ ¢ Shift+Z Cut the selection and store it in the clipboard Ctrl+X, or ¢ Shift+Del 3 Cmd+X Ctrl+X Ctrl+w x or "ax to cut in
register "a" or "+x to cut in system clipboard Ctrl+X Copy the selection into the clipboard Ctrl+C, or Ctrl+Ins 3 Cmd+C Ctrl+C Meta+w, or Ctrl+Ins y or "ay or "+y Ctrl+C Paste contents of clipboard at cursor Ctrl+V,or t Shift+Ins 3 Cmd+V Ctrl+V Ctrl+y, or t Shift+Ins p or "ap to paste the content of the "a" register or "+p to paste the content
of the system clipboard Ctrl+V Paste special B Win+V Shift+Opt+Cmd+V Ctrl+  Shift+V Meta+y Ctrl+  Shift+V Search+V Select all in focused control or window Ctrl+A 3 Cmd+A Ctrl+A Ctrl+x, then h ggVG, unlikely ever needed as most commands take an optional range parameter. % means "all in focused windows" here so e.g. to copy all the
text, use :%y Ctrl+A Cycle through installed keyboard languages / input methods Alt+ ¢ Shift, Ctrl+ ¢ Shift, @ Win+Space, B Win+ 1 Shift+Space Alt+ 0 Shift changes between languages while Ctrl+  Shift changes between keyboard layouts of the same language. The latter two display a menu with the currently selected input method highlighted,
and debuted in Windows 8. B Win+ { Shift+Space goes through the list backwards. For the first two shortcuts going backwards is done by using the right ¢ Shift key instead of the left. Fn or 3 Cmd+Space on older devices (not MBR) Configure desired keypress in Keyboard and Mouse Preferences, Keyboard Shortcuts, Select the next source in Input
menu.[1] Ctrl+Alt+K via KDE Keyboard Alt+ 1 Shift in GNOME Ctrl+\ Ctrl+Space Print Ctrl+P 3 Cmd+P Ctrl+P Ctrl+P Open Help Menu F1 in GNOME Ctrl+Search+S Windows Mobility Center Windows 7: B Win+X Windows 10: B Win+X then B PowerUser (WinX) Menu Windows 10: B Win+X Restart Video Driver Windows 10: Ctrl+ ¢ Shift+m®
Win+B[2][3] Action Windows macOS[notes 1] Linux ChromeOS Lock desktop B Win+L[4] Ctrl+3 Cmd+Q[5] (macOS High Sierra and greater)or Ctrl+ ¢ Shift+Eject or MBR Ctrl+  Shift+Pwr (If "Require password after sleep or screen saver" is enabled in "System Preferences — Security & Privacy") Super+L (GNOME)[6] or Ctrl+Alt+L Search+L
Log out user f Shift+3 Cmd+Q Ctrl+Alt+Delete Ctrl+ # Shift+Q (Twice) Switch active user B Win+L[notes 3] Applications menu B Win or Ctrl+Esc Ctrl+F2, then "n"[notes 2] Super or Ctrl+Esc Search Run application B Win, enter executable name or B Win+R, enter executable name ¥# Cmd+Space, enter executable name or 3 Cmd+ | Alt+F2,
enter executable name Search B Win, enter executable name or B Win+S or F3 3 Cmd+Space B Win (Gnome) Search Show desktop B Win+D Fn+H or F11 Ctrl+Alt+D Access SysTray B Win+B 1 Shift+Alt+S Switch window (next/previous) Alt+Tab &/ 0 Shift+Alt+Tab 'S 3 Cmd+Tab s/ 3 Cmd+ ¢ Shift+Tab & (While in app switching window, 3
Cmd+" can be used to select backward, 8 Cmd+1 can be used to view selected app's windows) Alt+Tab 5 / Alt+ 1 Shift+Tab ' or Alt+Tab % / Alt+ § Shift+Tab  to switch windows within the same application (Gnome) Hold Alt, then quickly press Tab 5 Switch window without dialog (next/previous) Alt+Esc / § Shift+Alt+Esc Only works within
single Applications 8 Cmd+" / 8 Cmd+ 0 Shift+" Task manager Ctrl+ 1 Shift+Esc,Ctrl+Alt+Delete[notes 4] X Opt+3 Cmd+Esc(summons "Force Quit Applications" window) Search+Esc File manager B Win+E Super+F # Shift+Alt+M New folder Ctrl+ # Shift+N 0 Shift+3 Cmd+N Ctrl+ 0 Shift+N Ctrl+E Rename object F2 < Enter[notes 5] or F2
F2 Ctrl+ < Enter Show hidden files Alt+V, then H, then H again, while in File Explorer, will toggle setting ¢ Shift+3 Cmd+., while in Finder, will toggle setting Ctrl+H, Alt+. in KDE Ctrl+. Action Windows macOS Linux ChromeOS Place computer into sleep/standby mode Windows 10: B Win+x > u > s Windows 7: B Win+—-+-+ < Enter Sleep
(available on some keyboards) C Opt+3 Cmd+Eject Sleep (available on some keyboards, configurable in Control Panel > Power Options > Advanced tab dialog box) Shut down computer Windows 10: B Win+x > u > u Ctrl+\ Opt+3 Cmd+Eject (no confirmation, shutdown is immediate) Ctrl+Alt+ ¢ Shift+PageDown (KDE; no confirmation, shutdown
is immediate) (GNOME; there is no default shortcut)[6] Power (Hold for 10 seconds) Restart computer Windows 10: B Win+x > u > r Windows 7: B Win+-+-+ 14+« Enter Ctrl+ 3 Cmd+Eject[7] or Ctrl+3 Cmd+Power (no confirmation, restart is immediate) Ctrl+Alt+ ¢ Shift+PageUp (KDE; no confirmation, restart is immediate) Place display in sleep
mode Ctrl+ 0 Shift+Eject where is lined Bring up power/sleep dialog box Ctrl+Eject Force shutdown Power (Hold for several seconds) \ Opt+3 Cmd+Eject or Hold Power for 10 seconds refresh+power Action Windows macOS Linux ChromeOS Save screenshot of entire screen as file B Win+Print Screen ¢ Shift+3 Cmd+3[8] Print Screen[9]
Ctrl+Show Windows Copy screenshot of entire screen to clipboard B Win+Print Screen or Print Screen Ctrl+ # Shift+3 Cmd+3 Ctrl+Print Screen Ctrl+Show Windows Copy screenshot of active window to clipboard Alt+Print Screen Ctrl+Alt+Print Screen Save screenshot of window as file # Shift+3 Cmd+4 then Space then move mouse and click
Alt+Print Screen (GNOME) Ctrl+Alt+Show Windows then move mouse and click Copy screenshot of window to clipboard Ctrl+  Shift+3 Cmd+4 then Space then move mouse and click Alt+Print Screen (GNOME) Ctrl+Alt+Show Windows then move mouse and click Save screenshot of arbitrary area as file § Shift+3 Cmd+4 then click+drag mouse
over required area Print Screen click+drag mouse over required area, then < Enter (GNOME) Ctrl+  Shift+Show Windows then click+drag mouse over required area Copy screenshot of arbitrary area to clipboard (Snip) Windows 10: B Win+  Shift+S Ctrl+ ¢ Shift+3 Cmd+4 then click+drag mouse over required area Print Screen click+drag
mouse over required area, then < Enter (GNOME) Ctrl+ ¢ Shift+Show Windows then click+drag mouse over required area Screencasting Ctrl+Alt+ t Shift+R (GNOME[10][11]) Ctrl+ ¢ Shift+Show Windows then select the Screen Record button on the toolbar Screenshot Utility § Shift+3 Cmd+5[12] Print Screen Ctrl+ ¢ Shift+Show Windows Save
screenshot of the Touch Bar as file t Shift+3 Cmd+6[13] Many of these commands may be combined with ¢ Shift to select a region of text.[14][15][notes 6] In macOS, holding ¥ Command while dragging mouse can be used to invert selection, and holding "\ Option can be used to select by rectangular area in some apps. (These two functionalities
may be combined). In macOS, the default text editing keyboard shortcuts in Cocoa text views can be overridden and new custom shortcuts can be created, by creating and editing related configuration files.[16][notes 7] Action Windows macOS[notes 1] Linux Emacs Vim ChromeOS Delete char to the right of cursor Del or Fn+«< Backspace Del or
Fn+< Backspace or Ctrl+D Del Ctrl+d x Alt+«< Backspace or Search+« Backspace or Del Delete word to the right of cursor Ctrl4+Del X Opt+Del or " Opt+Fn+«< Backspace Ctrl+Del Meta+d dw (delete space too) or de (keep space) Ctrl+Search+«< Backspace Delete word to the left of cursor Ctrl+«< Backspace T Opt+«< Backspace Ctrl+«<
Backspace Ctrl++« Backspace or Meta++« Backspace dge (delete space too) or db (keep space) Ctrl+«< Backspace Go to start of line Home or Fn+« 3 Cmd+« (go to start of line)or Ctrl+A (go to start of paragraph) Home Ctrl+a or Home ” (go to first non-space) or 0 (go to column 0) Search+« Go to end of line End or Fn+- 3 Cmd+- (go to end of
line)or Ctrl+E (go to end of paragraph) End Ctrl+e or End $ Search+— Go to start of document Ctrl+Home # Cmd+ T Ctrl+Home Meta+< or Ctrl+Home gg Ctrl+Search+« Go to end of document Ctrl+End 3 Cmd+ | Ctrl+End Meta+> or Ctrl+End G Ctrl+Search+— Go to previous word Ctrl+« or Ctrl+/ \C Opt+«< or Ctrl4+\ Opt+B Ctrl+« Meta+b
or Ctrl+« or Meta+« b or ge Ctrl+« Go to next word Ctrl+— \_ Opt+- or Ctrl+\ Opt+F Ctrl+—- Meta+f or Ctrl4+—- or Meta+— w or e Ctrl+— Go to previous line T T or Ctrl+p T Ctrl+por T kor T T Go to nextline | | or Ctrl+n | Ctrl+nor | jor | | Go to previous line break (paragraph) Ctrl+ T \ Opt+ T Ctrl4+ T (kword or GNOME) Meta+( or
Control+ 1 ( Ctrl+ 1T Go to next line break Ctrl+ 1 \ Opt+ ! Ctrl+ | (kword or GNOME) Meta+} or Control+ | ) Ctrl+ |l Move the cursor down the length of the viewport Page Down T Opt+PageDn or \ Opt+Fn+ | or Ctrl+V Page Down Ctrl+v or Page Down Ctrl+f or Page Down Search+ | Move the cursor up the length of the viewport Page Up
Opt+PageUp or \ Opt+Fn+ T Page Up Meta+v or Page Up Ctrl+b or Page Up Search+ T Find Ctrl+F 8 Cmd+For 3 Cmd+E (search with current selection) Ctrl+F Ctrl+K (GNOME; interactive search) Ctrl+s / Ctrl+F Go to next search result F3 3 Cmd+G Ctrl+G (GNOME) or F3 (KDE)[17] Ctrl+s n Ctrl+G or < Enter Go to previous search result
Shift+F3 ¢ Shift+3 Cmd+G Ctrl+ ¢ Shift+G (GNOME) or t Shift+F3 (KDE)[17] Ctrl4+r N Ctrl+ ¢ Shift+G or § Shift+ < Enter Search and replace Ctrl+H # Cmd+F Ctrl+H (GNOME) or Ctrl+R (KDE) Meta+% %s/fosh/fish/gc[notes 8] Ctrl+ ¢ Shift+H Search with a regular expression Ctrl+Meta+s All searches use regular expressions. Search and
replace with a regular expression Ctrl+Meta+% Emoji Picker B Win+. or B Win+; Ctrl+3 Cmd+Space Search+ f Shift+Space Action Windows WordPad macOS[notes 1] Linux[18] Emacs Vim Bold Ctrl+B 3 Cmd+B Ctrl+B Meta+o, then b Underline Ctrl+U ¥ Cmd+U Ctrl+U Meta+o, then u Italic Ctrl+I 3 Cmd+I Ctrl+I Meta+o, then i Uppercase /
Lowercase Ctrl+  Shift+A = Opt+3 Cmd+C 0 Shift+F3 Meta+u for upper, Meta+l1 for lower, Meta+c for capitalized. gU for upper, gu for lower, ~ to toggle. Superscript Ctrl+ ¢ Shift+= Ctrl+3 Cmd++ (some applications only) Ctrl+ ¢ Shift+P[19] Subscript Ctrl+= Ctrl+3 Cmd+- (some applications only) Ctrl+  Shift+B[19] Selected text
larger/smaller Ctrl+>, Ctrl+< or Ctrl+[, Ctrl/core+] or Ctrl+t Shift+>, Ctrl+ ¢ Shift+



